No part of this documentation may be reproduced in any form whatsoever or be stored in any data retrieval system without prior written permission of the copyright owners.

This documentation is supplied on an as-is basis. Information contained within this documentation is subject to change at any time without notice and must not be relied upon.

All company and product names are ™ or Registered Trademarks ® of their respective owners. Windows 7, and Windows 10 are trademarks of Microsoft Corporation.

Merging Technologies makes no warranties express or implied regarding this software, its quality, performance, merchantability or fitness for a particular purpose. The software is supplied “as is”, you, the purchaser, are assuming the entire risk of the results of using this Merging Technologies software.

In no circumstances will Merging Technologies, its owners, directors, officers, employees or agents be liable to you for any consequential, incidental or indirect loss or damages including loss of time, loss of business, loss of profits, loss of data or similar resulting from the use of or inability to use the Merging Technologies hardware and or software or for any defect in the hardware software or documentation.

© Copyright Merging Technologies Inc. 2018. All rights reserved
# Installation Guide v11.x: Contents

1 Introduction 6
   Thank you! 6
   Scope 6
   Windows 10 - IMPORTANT! 6

2 Pyramix Versions - Compatibility and Installation Steps 8

3 For Users Performing Upgrades 10

4 System Requirements 12
   Pyramix MassCore Systems 12
   Pyramix Native 12

5 PC Setup 13
   Motherboard Drivers and Utilities 13
   BIOS Settings 13
   Configuration Guides 13
   Display Settings 14
   Power Management 15
   Aero graphics 15
   Indexing 15
   Other Applications 15
   Video in Timeline / PyraCube 15
   Video Hardware 15

6 Pyramix Software Installation 16
   Installation Overview: 16
   Flux VS3/V3 plug-ins 16
   VB VS3 plug-ins 16
   Running the Installer 17

7 Pyramix Software Registration 18

8 MassCore Installation 20
   64 Bit MassCore Notes 22
   Re-licencing MassCore 64 bit RTX 24

9 MassCore - RAVENNA 25
   Installing the Merging Technologies NET-MSC-GBEX1 PCIe Ethernet Controller Card 25
   Troubleshooting 29

10 Native - ASIO 31

11 First launch 33

12 Troubleshooting 35

13 Lost or Stolen Merging Technologies Security Keys 35

14 Contacting Merging 36
   International Office: 36
   UK: 36
   USA: 36

15 Index 37
1 Introduction

Thank you!

Congratulations on your purchase of Pyramix Virtual Studio. More than just a product, this is a gateway to the future of sound recording, editing, mixing and mastering. You have joined a worldwide community of users who have already discovered the Pyramix advantage.

**Note:** IMPORTANT! - The first thing you need to do is register your software to acquire your Pyramix key(s) and to be included in our user support list.

http://www.merging.com/register

Please also subscribe to the User Forum at:

http://forum.merging.com

Scope

Pyramix Virtual Studio is a powerful and flexible Digital Audio Workstation (DAW) integrating hard disk recording and editing, digital audio mixing, effects processing, metering, machine control, video and mastering. Complete turnkey systems are available.

This document is intended to get you up and running with Pyramix, Pyramix MassCore and Pyramix MassCore RAVENNA as quickly as possible. For more detailed information about the Horus / Hapi hardware and the Pyramix software please see their specific Guides.

**Important!** If you are installing an upgrade to Pyramix please read: *For Users Performing Upgrades on page 10* first.

If you have purchased Pyramix Virtual Studio as an integrated (Turnkey) system, the installation information in this guide will be redundant, since these systems come with all hardware and software pre-installed. If you are configuring your own system, please refer to the following instructions.

Windows 10 - IMPORTANT!

**Note:** Merging **strongly recommends** you **defer feature updates** in Windows 10. Windows 10 users should never update to Beta Windows versions or install major new updates before making sure they are supported by Merging. Please refer to our Windows 10 Configuration Guide:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Details about the recommended Windows 10 Defer Update setting

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Defer+Updates

Windows 10 Recommended Version for MassCore

Pyramix v11.0.6 HotFix is supported under the following Windows 10 updates:

- Anniversary (1607)
- Creator (1703)
- Fall Creator (1709)

As well as the latest Meltdown and Spectre Windows updates.

Users wishing to apply Windows updates may refer to the Merging list of validated Compatible Windows updates:

https://confluence.merging.com/pages/viewpage.action?pageId=25755762

**Important!** Before you perform a Windows 10 update to Windows Fall Creator (1709) on a system already running a MassCore version it will be important for users to **remove** MassCore from the MT Security MassCore tab prior to performing a system update.
**Updating from Windows 7 to Windows 10**

Users performing an update from Windows 7 to Windows 10 should proceed in this way:

https://confluence.merging.com/display/PUBLICDOC/Updating+Windows+7+to+Windows+10+Anniversary+1607

**Note:** Users wanting to update to Windows Creator **must** follow the procedure document here:

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Update+from+Anniversary+to+Creator

**Note:** Once the update to Windows Creator has been completed follow this Pyramix v11 and MassCore installation Guide.

**For Pyramix v11 Native users**

Pyramix Native users may use the **Windows 10 Creator** update (1703), **Fall Creator** (1709) or **Anniversary** (1607).
2 Pyramix Versions - Compatibility and Installation Steps

Native (ASIO on 3rd party hardware):
Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit

Installation Steps:
• Pyramix Software Installation, See: Pyramix Software Installation on page 16
• Entering Authorization Keys, See: Pyramix Software Registration on page 18
• Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel) See: Configure ASIO in the VS3 Control Panel on page 31

Native with ASIO for RAVENNA and Horus / Hapi:
Compatibility: Windows 7 Professional 64-bit and Windows 10 Professional 64-bit

Installation Steps:
• Install the Merging RAVENNA ASIO Driver provided with your Horus / Hapi or available from: http://www.merging.com/download
• Select ASIO and the correct card/device in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)
• Optional: Pyramix Software Installation See: Pyramix Software Installation on page 16
• If Pyramix Software is installed: Entering Authorization Keys See: Pyramix Software Registration on page 18
• Select the desired network adapter in Merging RAVENNA ASIO Panel (Start Menu > All Programs > Merging Technologies > Merging RAVENNA ASIO Driver > Merging RAVENNA ASIO Panel) please see details in the Merging RAVENNA ASIO and CoreAudio Guide available in Start Menu > All Programs > Merging Technologies > Documentation > Merging RAVENNA ASIO Driver > Merging RAVENNA ASIO Panel
• Select ASIO/RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel) See: Configure ASIO in the VS3 Control Panel on page 31

Mykerinos only:
Not supported from version 10.x. Last compatible version is Pyramix v7.1 32-bit installer.

MassCore with Mykerinos:
Not supported from version 10.x. Last compatible version is Pyramix v9.1 32-bit installer.
MassCore with RAVENNA and Horus / Hapi:

**Note:** Merging strongly recommends users to perform a Windows Update prior to installing Pyramix v11.

**Installation Steps:**
- NET-MSC-GBEX1 Installation, See: Installing the Merging Technologies NET-MSC-GBEX1 PCIe Ethernet Controller Card on page 25
- Pyramix Software Installation, See: Pyramix Software Installation on page 16
- Entering Authorization Keys, See: Pyramix Software Registration on page 18
- MassCore Installation, See: MassCore Installation on page 20
- Select MassCore with RAVENNA in the VS3 Control Panel (Start Menu > Control Panel > VS3 Control Panel)

---

**Quick Setup Checklist For Systems with Horus / Hapi**

1. Shut down the system and install the MassCore NET-MSC-GBEX1 PCIe Ethernet controller card. (Card drivers are included in the Pyramix and Ovation installers.)
2. Existing users of 64 bit MassCore must uninstall the previous MassCore version from the MT Security application.
3. MassCore users MUST configure their BIOS settings. Please see: BIOS Settings on page 13
4. Disable Windows Firewall in Windows Control Panel Security
5. Install Google Chrome
6. Install Pyramix v11.x or Ovation v7.x.
7. Enter your new MassCore (RTX64 - 3.0) key in MT Security Settings then import your v11/v7keys in MT Security Settings.
8. On a fresh install also in MT Security Settings install MassCore from the MassCore Tab.
9. MassCore SMP users (recommended for i7 CPU configurations and above) should launch the VS3 Control Panel and assign 2 cores to MassCore. (A reboot will be required.)
10. In the VS3 Control Panel ensure that RAVENNA is selected in the Hardware section.
11. Configure the Switch/Router (if present). Please refer to the RAVENNA Network Guide
12. Launch Pyramix
13. You can also launch the MTDiscovery application and double-click on the Horus / Hapi entry for browser remote access.
14. Ensure that the Horus / Hapi is set to the same sampling rate as Pyramix or Ovation. A warning prompt will appear if this is not the case.
15. Configure I/O as required in Pyramix/Ovation and Horus /Hapi. RAVENNA users should consult the ANEMAN User Manual.
3 For Users Performing Upgrades

**Note:** Pyramix v11 keys are required and users running MassCore will need a new MassCore version (RTX64 - 3.3) this requires the RTX 3.0 key.

**Pyramix**
We recommend uninstalling any previous version of Pyramix before installing Pyramix 11.0.

From the Windows Control Panel select **Programs and features**.

Remove the installed version of Pyramix.

**Note:** Merging recommends installing v11.0 **BEFORE** uninstalling the previous version of MassCore. **UNLESS** you are planning to update your Windows 10 version and already have a MassCore version installed, then you must follow the procedures in these documents:

- [https://confluence.merging.com/display/PUBLICDOC/Windows+10+Update+from+Anniversary+to+Creator](https://confluence.merging.com/display/PUBLICDOC/Windows+10+Update+from+Anniversary+to+Creator)
- [https://confluence.merging.com/display/PUBLICDOC/Windows+10+Update+from+Creator+to+Fall+Creator](https://confluence.merging.com/display/PUBLICDOC/Windows+10+Update+from+Creator+to+Fall+Creator)

**Note:** IntervalZero version should read: **IntervalZero RTX64 3.3** version 3.3.1.4103

**VCube**
Pyramix 11.0 can coexist with VCube Version 7.0. (Be aware of recommended configurations.)

**Masscore**
MassCore users **MUST** remove the existing MassCore runtime.

Once Pyramix 11.0 is installed follow these steps:

1. Launch **MT Security Settings** and select the **MassCore** Tab.
2. Choose the **Uninstall MassCore RunTime** option and reboot. (There will be one reboot.)
3. Reboot selecting the **NON-MassCore** Windows Boot line. If you experience any problems please refer to the troubleshooting document here:
   - [https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting](https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting)
4. Launch **MT Security Settings** and enter your v11 keys and enter your new RTX64- 3.0 MassCore key, which is required in order to run Pyramix v11 with MassCore.

**Warning!** If when entering your new MassCore key you experience a failure message, please contact keys@merging.com and let us know your Dongle serial number so that Merging can identify your current **MassCore/RTX64 key** and renew it if necessary.

**Note:** RTX DONGLE USERS (SSK-HUD-RTX) if this is the first time of using the dongle on this computer please download and install the driver **before** installing the MassCore runtime:


Select: **Sentinel HASP/LDK - Windows GUI Run-time Installer**

Run the installer following the instructions.
5. Select the **MassCore** Tab and choose the **Install MassCore RunTime** option.

6. An RTX64 Driver approval dialog may appear. Accept it, click on **OK** to close the **MT Security Settings** panel and reboot the system.

   **Note:** Please note that the installation process can take some time.

7. After installation you should see an **Interval Zero** entry in **Windows Control Panel > All Control Panel Items > Programs and Features**. This should read: **Interval Zero RTX64 3.3 Runtime (Version 3.3.1.4103)**.

8. Launch the **VS3 Control Panel** and configure it for **MassCore - RAVENNA**. See: **Configure RAVENNA in the VS3 Control Panel** on page 27
4 System Requirements

Wintel platforms tend to increase in number of cores, speed and performance at a tremendous rate. New and faster processors are released almost on a monthly basis. Therefore we have not included suggested Motherboard or Processor specifications here.

We maintain a list of up to date PC configurations in the Support Section of our website at:

http://www.merging.com/pages/pccconfig

Other Components

- **Graphics Card:** As of Pyramix 11, Ovation 7 and VCube 7, Merging strongly recommends using a dedicated graphic card rather than onboard graphics. Most particularly when the following are required
  - Multiple display outputs,
  - OpenGL UI plugins (Flux, Izotope, ...)
  - Working with video, or when your workflow places high demands on graphics.

Please refer to the Pyramix v11 PC Specifications for all details:

http://www.merging.com/pages/pccconfig

- Sufficient HD space and speed for your audio media files. The speed and amount of disk space required depends on sample rate, word length, number of tracks and length of program material.

- A typical 7200 RPM SATA drive is sufficient for 48 tracks at 48 kHz. Higher track-counts and/or higher sampling rates will require an SSD drive and/or multiple drives configured in Raid 0, 1, 10 or 5

- We recommend disks should be formatted as **NTFS** volumes with 64kB block sectors for audio. For video 128kB block sectors are desirable.

- **BD/DVD/CD-ROM** combo drive or better.

- Multiple 19” or larger monitors highly recommended.

  **Minimum resolution 1280x1024**

- 3 button mouse

**Pyramix MassCore Systems**

**Certified Operating Systems**

- **OS:** We recommend and certify **Pyramix Version 11.x and later** under **Windows 7 Professional 64-bit** and **Windows 10 Professional 64-bit**.

**Pyramix Native**

**Certified Operating Systems**

- **OS:** We recommend and certify **Pyramix Version 11.x** under **Windows 7 Professional 64-bit** and **Windows 10 Professional 64-bit**.
5 PC Setup

Motherboard Drivers and Utilities

Motherboard drivers should be updated to current versions.
Motherboard Utilities should **NOT** be installed.
Please refer to our Windows configurations guide for more details:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

BIOS Settings

Recommended BIOS Settings

Boot Device Control
We recommend that the **UEFI** boot should be disabled and set to:

**Boot Device Control: Legacy only**

Hyperthreading

Intel® Hyperthreading Technology is supported on 64 bit MassCore systems. This setting is commonly found in Main Bios page, or under CPU configuration. (see the motherboard manual for further details).

- MassCore SMP users: Merging Recommends that Hyperthreading is **enabled** to benefit fully from the real-time engine power, VS3 support and the MassCore multithreaded engine.
- MassCore Non-SMP users: Will gain some of these benefits by **not enabling** Hyperthreading, so that a full single Core is dedicated to MassCore
- For further information refer to the Pyramix User Manual chapter *MassCore & VST Core Allocation.*
- Pyramix Native: We recommend that Hyperthreading is **enabled.**

Other Settings

The following features can create MassCore overloads (blinking red MSC).

Intel® Speedstep Technology (also known as Enhanced Intel® SpeedStep), as well as CPU C State (or Intel® C-State) features must be **disabled** in the BIOS.

Some Recent Intel boards have a global setting to disable those features known as Intel® Dynamic Power Technology. If present this should be **turned off.** These settings are commonly found in BIOS Power options or CPU Configuration.

Overclocking is **not** supported.

Configuration Guides

Windows 10 users should refer to the *Merging Windows 10 Configuration Guide:*

https://confluence.merging.com/display/PUBLICDOC/Windows+10+Configuration

Merging has a number of specific PC-configuration guides which are available on request. Tell us your system configuration modeled on our recommendations at:

http://www.merging.com/support/pc-config

so that we can send you the latest configuration guide. Please contact:

support@merging.com
**Display Settings**

Pyramix requires a minimum display resolution of 1280x1024 in 256 colors which **MUST** be set to *small fonts* mode.

A Merging Windows configuration guide is available with recommendations here:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

**Windows Control Panel > System > Advanced System Settings** opens the **System Properties** window. Select the **Advanced tab > Performance Settings** to open the **Performance Options window**. Choose the **Visual Effects** Tab:

**Windows 7**

<table>
<thead>
<tr>
<th>Onboard Graphics (Intel)</th>
<th>Dedicated Graphic Card</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Onboard Graphics" /></td>
<td><img src="image" alt="Dedicated Graphic Card" /></td>
</tr>
</tbody>
</table>

**Windows 10**

![Visual Effects Tab](image)
Disable the following settings by unticking the boxes to prevent MassCore peaks:

- Animate Windows when minimizing and maximizing - disable
- Animations in the taskbar and Start Menu - disable
- Aero Peek - disable
- Enable desktop composition - disable (Windows 7 Only)
- Enable transparent glass - disable
- Fade or slide menus into view - disable
- Fade or slide ToolTips into view - disable
- Save taskbar thumbnail previews - disable
- Show translucent selection rectangle - disable
- Show window content while dragging - disable
- Slide open Combo boxes - disable

**Power Management**

*N.B.* As with other Digital Audio Workstations and Non-Linear Editors, we recommend setting the PC to the **High Performance** Power management scheme or **RTX64-Recommended** (MassCore Users).

MassCore is **NOT** designed to support Standby modes.

**Aero graphics**

Disable AERO themes for maximum performance. (Windows 7 Only)

**Indexing**

In the interests of better performance we recommend turning Indexing **OFF** for all Data drives in the system.

**Other Applications**

Like all Digital Audio Workstations, Pyramix works best when there are no other unnecessary applications or services running.

**Video in Timeline / PyraCube**

As of Pyramix 11, Ovation 7 and VCube 7, Merging strongly recommends using a dedicated graphic card rather than onboard graphics.

In a Pyramix Native system video performance depends principally on the system configuration. Laptop users must set the **Windows Power Scheme** to **High Performance**.

Please refer to our list of recommended configurations for more details:

http://www.merging.com/support/pc-config

And our **Configuration Guide**:

https://confluence.merging.com/display/PUBLICDOC/Windows+Configuration+Guide

**Video Hardware**

Merging supports Blackmagic design Video Cards thru the DeckLink SDK. This covers: **DeckLink**, **UltraStudio** and **Intensity** product lines. Decklink Studio 4K, Decklink 4K Extreme and Decklink 4K Pro have been validated. The **DeckLink Studio monitor** is known to be working but has no Video reference to ensure genlock. The recommended Blackmagic Design installer version is 10.3.7 and above, the latest version certified is 10.9.7. Please download and install from:

https://www.blackmagicdesign.com/support
6 Pyramix Software Installation

**Important!** If you have not already done so, before installing the Merging Technologies software for the first time OR as an update please run Windows Update and accept any updates marked as **Important**. Note that this can take a considerable time. (Over an hour in some cases.) This is a Microsoft problem.

**Note:** You must have full Administrator Access to install Pyramix.

**Installation Overview:**

**Note:** If you have purchased hardware options such as the NET-MSC-GBEX1 PCIe Ethernet card, the Sync Board and or a Blackmagic or AJA video card, please install these following the instructions in the accompanying documentation. The drivers for all of these except Blackmagic cards, ADR Keyboard and SeaLevel GPIOs are installed automatically with the Pyramix software.

**Note:** Where applicable Blackmagic video card drivers have to be downloaded from the Blackmagic website and installed separately. The recommended Blackmagic Design installer version is 10.3.7 and above, the latest version certified is 10.9.7 Please download and install from:

https://www.blackmagicdesign.com/support

**Installer**

The Pyramix software uses an automated installer wizard which will install all necessary prerequisites. Installing Ovation will also install Pyramix.

You may exclude the installation of any of the individual components in the wizard, if the device in question is not present on your machine or if you do not intend to use an item, by un-ticking the tick boxes next to the items listed in the wizard.

**Note:** The security dongle must be in place and the security keys entered before attempting to launch the software.

**Flux VS3/V3 plug-ins**

Download the Flux Center application in order to install the Flux VS3 plugins:

https://www.fluxhome.com/download

More details here:

https://confluence.merging.com/display/PUBLICDOC/Flux+Download+Center

Ensure you have valid Merging Flux v3 Keys in order to run these Flux VS3 plug-ins.

**VB VS3 plug-ins**

VB VS3 plug-ins are installed by default with a complete Pyramix install. If you do not wish to have them installed, e.g. in evaluation mode or if you do not have valid keys then select **Custom** during the Pyramix install and remove them from the install by right-clicking on them.
Running the Installer

**Note:** If you have a SafeNet dongle please remove this before installing Pyramix and replace it after installation is complete.

**Note:** The HASP dongle is not supported on 64-bit systems. If you have a HASP dongle please contact your Merging Technologies Sales Partner to purchase a SafeNet dongle and transfer your keys.

Once the NET-MSC-GBEX1 Ethernet card has been properly installed, you can now install the Pyramix 10.x software.

To install the Pyramix Virtual Studio v11.x software insert the USB memory stick. The installation program will auto-start on a PC where auto-start is configured on. Otherwise, double-click on the USB memory stick icon. Please follow the automatic installation procedure accepting the option to install unsigned drivers and re-boot your PC once setup is complete.

**Note:** For Windows 7 Users Only: The installer checks and verifies if the Windows 7 updates KB3033929 and KB3123479 are present on the system and if not installed already (from running Windows Update manually or automatically) they will be installed for Windows 7. If the updates are required, please be patient. The update can take as long as one hour. This delay is caused by Microsoft. An extra re-boot is required once the updates are installed.

**N.B.** If the Windows Update Service is disabled, Windows cannot install any updates, one consequence will be that the MassCore NIC will not work. To check if the Service is running open the Windows Control Panel, go to Administrative Tools > Services and ensure that the Windows Update service is started and therefore running. If the Service is stopped it can be started manually by selecting it and choosing Start in the Action menu or from the right-click context menu.

**Note:** This update is already embedded in Windows 10.

**Note:** For Windows 7 Users: If the installation appears to freeze for a long period please check that the Driver Signing warning dialogue is not hidden behind another Window. Installation will not continue until you click OK in this dialog.

**WARNING:** Certain computers do not properly shut down despite the reboot command issued by the installer but only perform a log off. In this case, please activate a full shut down manually.
7 Pyramix Software Registration

The Pyramix Virtual Studio software and its various software options are protected by an authorization key mechanism which uses a unique registration key number generated by Merging Technologies. Based on purchased software components, this key is unique to your security dongle, your Company Name and your User name. Once you have registered your software you will be provided with this Key or Keys (depending on the chosen options).

If you did not receive this key, have lost it or would like to change the user and/or company name, please contact your Merging Sales Partner with your SafeNet dongle serial #, your User Name, your Company Name and the list of purchased software components. Usually, a key can be issued within one business day, after the verification of your personal data has been completed.

Entering your Key(s)
After the Pyramix installation process you will be prompted to enter your Authorization Key. If you click Yes the MT Security Settings dialog will be launched automatically, allowing the Key or Keys to be entered immediately. If you choose not to enter your Key at this point you can do so later by choosing one of the following procedures:

1. Double-click the file YourPersonalKeyXXXXX.mtk. This is attached to the email containing your Key(s).
2. Open the MT Security Settings Control Panel (Windows Task Bar Start > Control Panel > MT Security Settings), click the Import Key button and browse for your Key file named:

   YourPersonalKeyXXXXX.mtk

3. Open the MT Security Settings Control Panel (as above), in the Registration section select the dongle number corresponding to the SafeNet Key, click the Enter Key button and type your User Name, Company Name and Key then click OK. Repeat this step for each Keys listed in the email.

Changing or re-entering a Key
Should you need to subsequently change or re-enter a Key, follow the appropriate option above.

Evaluation Mode
If started without a valid registration key, the software will recognize that no valid key is available and will start in “evaluation” mode, which only allows for basic operation of the software as follows:

- Limited to 2 channels of I/O on host soundcard
- No Project > Save function
- Tone is added to new recordings
- All optional extra cost features are deactivated

All editing functions, playback, file type conversions etc. are fully functional.
Keys
At any time you can check the serial number of your Security dongle and check the software options enabled in your system in the **MTSecurity** application.

MT Security Settings - Keys tab
8 MassCore Installation

System Requirements
A quad core Intel processor is the minimum requirement.

Conditions
- You **MUST** be logged in as an Administrator to install MassCore

  **Note:** You do not need to be logged in as an Administrator to **RUN** Pyramix with MassCore™, just to install it.

- You must have a NET-MSC-GBEX1-Ethernet card in your system.
- You must have a MassCore 48 (Base) Key in order to proceed with the installation. You must also have a MassCore 64bit (Base) key and an RTX 64 key. Please contact your Merging Technologies Sales Partner if you do not have these options but want to use MassCore.

MassCore Installation
1. Install v11.x Pyramix.exe and ensure you have a valid MassCore RTX64 key.
2. Restart your system after the Pyramix install.
3. If you had a previous version of MassCore installed open the VS3 Control Panel and choose the Uninstall MassCore RunTime option and reboot.
4. Once MassCore had been removed, reboot selecting the NON-MassCore Windows Boot line. If you experience any problems please refer to the Troubleshooting document here: https://confluence.merging.com/display/PUBLICDOC/MassCore+Uninstall+Troubleshooting
5. Enter Your Key(s) in MT Security Panel (Make sure you have a valid MassCore key.) The MassCore 64bit and RTX 64 keys are required for 64-bit systems.

  **Note:** RTX DONGLE USERS (SSK-HUD-RTX) if this is the first time of using the dongle on this computer please download and install the driver **before** installing the MassCore runtime: http://sentinelcustomer.safenet-inc.com/sentineldownloads/?s=&c=End+User&p=Sentinel+HASP+HL&o=all&t=all# Select: Sentinel HASP/LDK - Windows GUI Run-time Installer
6. For automatic RTX licence validation on 64-bit systems ensure the system is connected to the Internet during the MassCore installation. RTX Dongle users must have the dongle plugged in during the installation.
7. In the MT Security Panel select the MassCore Tab.
8. Press the **Install MassCore Run Time** button (will only be enabled if the **MassCore base, MassCore 64bit** keys and a valid RTX64 license code are present.).

*Please note that the installation process can take some time to proceed.*

9. A **Windows Security RTX Driver** approval dialog will appear:

10. Click **Install**. The installation progress window will appear:
11. When the install completes, click on OK in the Merging Technologies Security Settings dialog to close it.

12. Restart System after the install.

**Note:** Please note that the installation process can take some time. A second reboot is required to finalize the installation, the system will automatically restart after 30 seconds on the first reboot. After installation you should see an Interval Zero entry in Windows Control Panel > All Control Panel Items > Programs and Features. This should read: IntervalZero RTX64 3.3 Runtime (Version 3.3.1.4103).

13. Launch the VS3 Control Panel:

14. In the Platform section select MassCore

15. We recommend the use of Low latency or AES67 modes by default. Ultra low latency & Extra low latency are available for Horus / Hapi users with Pyramix v11.x recommended configurations.

http://www.merging.com/pages/pconfig

**64 Bit MassCore Notes**

- Double licence protection, both MassCore 64bit and RTX64 keys are required BEFORE MassCore installation. The MassCore 64 bit installation can be performed only if these two keys are present.
- The RTX64 Activation key licence is authorized automatically via an internet connection if present.
• Note that the RTX64 MassCore licence can only be installed ONCE per Windows installation, since it is locked to the system.

• At present if there is a requirement use MassCore Pyramix on two different computers regularly, it will be necessary to purchase a second MassCore 64bit Base key. Note that a solution exists for those who would like to have their MassCore/RTX64bit keys stored on a dongle (Hasp/IntervalZero), instead of having them linked to a unique system. This allows users to move their MassCore/RTX64 licensing to different systems by carrying two dongles (Merging-SafeNet & IntervalZero-HASP). This solution requires the purchase of an additional dongle. Please contact your local Merging Technologies sales office if you require this option. (Reference: SSK-HUD-RTX).
Re-licensing MassCore 64 bit RTX

If a system needs to be re-licenced for example after a Windows OS re-installation process or if it is necessary to move the licence to another system, then you should contact us at:

keys@merging.com

Please give the reason for your system migration or re-installation since the RTX64 key is not meant to be renewed frequently.

If Merging cannot follow up with a timely response (in emergency or at weekends) please contact the Interval Zero (RTX) sales team.

Please ensure that you have the RTX64 Authorization Key number (IZRTX64-030-XXXX-XXXX…) when doing so.

Interval Zero Support team:

sales@intervalzero.com
Certified Operating Systems (OS) for RAVENNA
Pyramix Version 11.x MassCore in RAVENNA mode is certified under Windows 7 Professional (64-bit versions) and Windows 10 Professional (64-bit versions) as of Pyramix v11.0.

System Requirements
We maintain a list of up to date PC configurations in the Support Section of our website at:
http://www.merging.com/pages/pconfig

Please refer to the MassCore-RAVENNA recommendations (Quad-Core is the minimum requirement)

Required Hardware
The Merging Technologies NET-MSC-GBEX1 PCIe Ethernet controller card is required for MassCore - RAVENNA.

Installing the Merging Technologies NET-MSC-GBEX1 PCIe Ethernet Controller Card
The NET-MSC-GBEX1 PCIe card should be installed in your computer before installing Pyramix v11.x

Procedure
1. Power down your PC and switch it off at the wall. Remove the screws securing the top or side of the case and carefully slide off the panel.
2. An anti-static wristband is sensible precaution whenever working with sensitive electrical equipment. Keeping one hand on a metal part of the case will have the same effect, though you may need both hands when installing certain items of hardware.
3. Locate an empty PCIe slot and remove the metal backing plate by removing the screw holding it in place and carefully sliding it up and out. In some cases, there are no backing plates and you will need to remove a length of metal instead. Do this using a flat-blade screwdriver and/or pliers, taking care to avoid any sharp edges left behind.
4. Remove the NET-MSC-GBEX1 card from its protective anti-static envelope and align it with the vacant PCIe slot as shown below.

5. Push down, gently at first, ensuring you have the pins aligned correctly with the slot, and then apply more pressure to slot the card fully home.

6. Use the screw which was used to retain the backing plate to secure the card in place and check that the card sits comfortably.

7. Finally, replace the case cover(s) and switch the machine back on at the socket.

8. At the next power up and boot Windows will discover the Merging Ethernet PCIe card.

Pyramix v11 can now be installed.

**Required Software**

In order to operate Pyramix with RAVENNA and Horus / Hapi, Pyramix v11 or later must be installed. The Pyramix v11 installer includes; ANEMAN along with Apple bonjour.

**Note:** Driver signing. Please tick *Always trust “Merging Technologies”* when the first warning message about unsigned drivers appears.

**Enter your Pyramix keys**

Launch *MTSecurity settings* and enter your Pyramix v11 keys. Please see Entering your Key(s) on page 18.

**Note:** v11 keys are required and MassCore requires a new RTX64 key in order to run RTX64 3.3.

**Install MassCore**

Please see: MassCore Installation on page 20

**Note:** A valid MassCore (Base) key and a valid MassCore 64-bit key are mandatory.

The MassCore key is held on the SafeNet dongle. Please make sure that you are in possession of a dongle and valid keys in order to operate Pyramix in MassCore-RAVENNA mode.

**Note:** The NET-MSC-GBEX1 Ethernet card requires MassCore in order to function.
Configure RAVENNA in the VS3 Control Panel

1. Launch the VS3 Control Panel (Start: All Programs > Merging Technologies > VS3 Runtime > VS3 Control Panel)
2. Cores Allocation Leave on the default setting for now.
3. For now, leave Latency on the default setting Low Latency
4. Select Platform: MassCore
5. Select Hardware: On Bus as RAVENNA (box ticked)
6. Audio Bridge: Set as required.
7. Click on the OK button.
8. When the VS3 panel Do you want to save routing? dialog box appears, click on OK
9. The VS3 control panel will close.

Before First Launch

Before launching Pyramix v11, you must ensure that a PTP Master* is present on your RAVENNA network. Merging Technologies recommends using its Horus or Hapi converters as PTP Master.

* The Precision Time Protocol (PTP) is a protocol used to synchronize clocks throughout a computer network.
**Note:** RAVENNA mode supports all three Latency modes. (VS3 Control Panel)
To enable RAVENNA I/O connections please refer to the separate RAVENNA Easy Connect Guide.

**Note:** Merging Technologies highly recommend **Low Latency** or **AES67** modes for optimal performance. The **Extra** and **Ultra** latency modes should only be used on Merging Turnkey systems or approved configurations since these modes can be very demanding on performance, depending on system configuration and user workflow.

**Note:** Horus / Hapi users should refer to the Horus / Hapi User Manual for configuration set-up with Pyramix.
Troubleshooting

RAVENNA: Horus / Hapi & Network configuration
Merging recommend that the Ethernet MassCore card and Horus / Hapi are configured to obtain an IP address automatically.

Setting Horus / Hapi and Network Card to Obtain IP Addresses Automatically

**Network Card**
1. Open **Network Connections** in the Windows **Control Panel**
2. Right-click on the MassCore Ethernet card NET-MSC-GBEX1 and open **Properties**.
3. Select **Internet Protocol Version 4, TPC/IPv4** (which is the only one activated) and click on **Properties**.
4. Select the **Obtain an IP address automatically** option.
5. Click on **OK** in each dialog to accept the changes and close the dialogs.

**Horus / Hapi**
1. Open the **Horus / Hapi Setup > Advanced > Network** page
2. In the **IP address** section select **Auto**

Setting Fixed IP addresses
1. First, check the IP address of the Horus / Hapi device under **Setup > Network**
To be able to see each other, the Merging Technologies Network card and Horus / Hapi must be in the same range of addresses. (for example 192.168.xxx.xx).
2. The Horus / Hapi IP address can be checked (and changed if required in the **Horus / Hapi Setup page > Network**)
3. The IP address of the MT Network card can be changed in **Windows Control Panel > Change Adapter Settings**
4. Right click on the Merging Technologies NIC and select **Properties**.
5. Select **Internet Protocol Version 4, TPC/IPv4** (which is the only one activated) and click on **Properties**.
6. Switch to **Use the following IP address** and enter an IP address that is in the same range as the Horus / Hapi IP address. The Subnet Mask should be added automatically.
7. Click on **OK** in each dialog to accept the changes and close the dialogs.
Windows Firewall and UAC
Recommendation
If not configured correctly, Windows Firewall can block communication between MassCore and Horus / Hapi. User Account Control should also be set to **Never Notify**.

Firewall
• Open the Windows **Control Panel**. Open the **System and Security** section and under **Windows Firewall** disable the Firewall for the Public Network.
• Go back to the Windows **Control Panel** and click on Windows **Firewall**. Click on **Change notification settings**. Ensure **Block all incoming connections, including those in the list of allowed programs** is **NOT** ticked.

User Account Control
• Open the Windows **Control Panel**. Open the **User Accounts** section and under **Change User Account Control Settings** move the slider down to **Never Notify**.

Antivirus
Recommendation
• Merging also recommends that any Antivirus software is properly configured so as to not interfere with the DAW. See this page for further details:

https://confluence.merging.com/display/PUBLICDOC/Antivirus+and+Merging+Technologies+Softwares
10 Native - ASIO

**Note:** Windows 10 Fall Creator update (1709) is Supported as of Pyramix Native v11.0.6 HotFix and above only. Previous Pyramix version will NOT run under the Fall Creator update (causes errors on launch).

Install Pyramix and the drivers for your ASIO device.

**Configure ASIO in the VS3 Control Panel**

1. Launch the **VS3 Control Panel** (Start: All Programs > Merging Technologies > VS3 Runtime > VS3 Control Panel)
2. Select **Platform**: Native - ASIO
3. Select **I/O Selection**: **Driver name**: Select your ASIO device from the drop-down list
4. **Audio Bridge**: Set as required.
5. Click on the **OK** button.
6. When the VS3 panel **Do you want to save routing?** dialog box appears, click on **OK**
7. The VS3 control panel will close.

The Inputs and Outputs present on the ASIO device will now be available in Pyramix.
RAVENNA ASIO

If you wish to use the RAVENNA ASIO driver with one of Merging Technologies RAVENNA interfaces. Please see the RAVENNA ASIO Guide here:

11 First launch

**Important!** After installation has been completed, please reboot the PC before attempting to launch Pyramix Virtual Studio. Then open the **VS3 control panel** application.

**Start:** All Programs > Merging Technologies > VS3 Runtime > VS3 control panel

**For Systems with MassCore RAVENNA**

Please see: [Configure RAVENNA in the VS3 Control Panel on page 27](#)

**For Native Systems**

Please see: [Configure ASIO in the VS3 Control Panel on page 31](#)

**Launch Pyramix**

Double-click on the **Pyramix Virtual Studio** desktop icon to launch Pyramix.

**Please see important information on next page!**

**Note:** At the first launch a firewall approval dialog may appear:

![Windows Security Alert dialog - Windows Firewall](#)

Click on **Allow access** since this is necessary to ensure correct Audio Connections and VT2 (Virtual Transport 2) functioning.

**Note:** For further information about options available in the VS3 Control Panel, please see the Pyramix User Manual.
**Note:** At first Pyramix launch and or after installing MassCore the following alert box may appear. If it does please reboot the computer one more time:

![VS3 error alert box]

**Documentation**

The [User Manual](http://www.merging.com/downloads) and [Quick Start Guide](http://www.merging.com/downloads) are available from within Pyramix and may be accessed via the Help menu or by pressing F1, or online at:

http://www.merging.com/downloads
12 Troubleshooting

Please visit regularly:

www.merging.com

for the latest Troubleshooting Guide and FAQ sections.

13 Lost or Stolen Merging Technologies Security Keys

(SafeNet USB Dongles)

The Merging USB Key carries all the value of your Merging software and the software licence authorization to use it. Please ensure you do not lose the USB key as Merging Technologies cannot be held responsible if this is lost or stolen.

If your USB key is lost or stolen then please make a claim on your insurance in the usual way just as you would for any other item you own. Merging will be happy to confirm the details and value of the software licence and USB key to your insurance company. If your USB key is lost or stolen and a different user should attempt to register for this key, Merging will notify you and the authorities in your country that an attempt has been made to register this stolen item.

If your USB key should become defective or is broken, please ensure this key is returned to Merging after requesting and RMA (Return Merchandise Authorization.) Only after the receipt of this key in the Merging Offices will it be determined if it may be exchanged under warranty free-of-charge, or if the damage is outside the warranty scope. In which case only a modest fee to replace it with a new key will be charged (and not the entire value of the software.)
14 Contacting Merging

International Office:
Merging Technologies S.A.
Le Verney 4
CH-1070 Puidoux
Switzerland
Phone: +41 21 946 0444

UK:
Merging UK (Emerging Ltd)
23 Campbell Court
Campbell Road
Bramley
Hampshire
RG26 5EG
UK
Phone: +44 (0) 118 402 5090
Fax: +44 (0) 870 123 1747
Email: sales@merginguk.com

USA:
Merging USA (Independent Audio)
43 Deerfield Road
Portland,
ME 04101-1805
United States of America
Phone: +1 (207) 773 2424
Fax: +1 (207) 773 2422

For all documentation inquiries or suggestions for improvement:
http://www.merging.com
Index

Numerics

64 Bit MassCore Notes 22

A

Aero graphics 15
Antivirus 30
ASIO
Native 31
RAVENNA 32

B

BIOS Settings 13
Blackmagic Design 15
BlackMagic video card drivers 16

C

Changing or re-entering a Key 18
Contacting Merging 36

D

Display Settings 14
Do you want to save routing? 27, 31

E

Entering Keys 18
Evaluation mode 18

F

Firewall 30
First launch
Single board system 30, 33
Fixed IP addresses 29
Flux VS3/V3 plug-ins 16

H

HASP 17

I

Import Key 18
Indexing 15
Installer 16
Introduction 6

K

Keys 19
Lost or Stolen 35

L

Latency modes 27, 28
Lost or Stolen Keys 35

M

MassCore

MT Security Settings 18

N

Native - ASIO 31
Native Install 17

O

Other Applications 15

P

PC Setup 13
Power Management 15
PyraCube 15

R

RAVENNA 25, 27
ASIO 32
Troubleshooting 29

S

SafeNet 17
SafeNet dongle 17
small fonts 14
Software Installation 16
Software Registration 18
System Requirements 12

T

Thank you 6
Troubleshooting 35

U

UAC 30
User Account Control 30

V

VB VS3 plug-ins 16
Video and Pyramix on one PC 15
Video Hardware 15
Video in Timeline 15
VS3 control panel 27, 31

W

Windows 10 6
Windows configuration guide 14
Windows Firewall 30, 33

Y

YourPersonalKey 18